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DISSCUSSION TOPICS: 

The following topics will be covered during this 

Provision Training class: 

 Opening Provision for the first time 

 Changing the Options/Preferences selections 

 Connecting to recorders 

 Recorder initialization setting 

 Custom Template usage 

 Creating custom graphs 

 Downloading recorder data 

 Setting up Watcher folders 

 Removing old data files 

 Editing graphs 

 Editing the Header report 

 Selecting graph plots 

 Exporting / E-mailing data, custom graphs, and 

templates 

 Importing data, custom graphs, and templates 

 Importing Winscan data 

 Keeping recorder Firmware current 

 Manual and White paper location 

 Recorder hookup diagrams 
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SHORTCUTS: 
 
GENERAL SHORTCUTS FOR MOST GRAPHS: 

q Brings up the same menu as right-clicking 

e,x Export dialog (Saves graphs as images) 

p Print graph 

s Toggle between color and Black and white 

d Export text dialog 

k Increase line thickness 

j Decrease line thickness 

b Set the upper and lower bounds 

m Maximize graph 

t Toggle the Point Table ON or OFF.  

         - Move your mouse to a peak on the graph, your  

        cursor will turn into a finger, left-click mouse to set  

        the reference line. 

       -With the Point Table ON you can: Use arrow keys  

          (or page up/down) to move the ‘Point’ to the  

          previous or next point. 

Zooming: Zoom in on any graph. Left click mouse and  

      hold, then drag mouse over the area to zoom in on.  

       Release the left button to zoom into the window 

    you made.  Supports multiple zooms. 

      - Use arrow keys to  move the zoomed window  

        Left or Right, through the interval data.  

u Undo one zoom level 

z Undo all zoom levels 
 
CONTROL KEY SHORTCUTS 

Ctrl+O: Open file  
Ctrl+X: Cut  
Ctrl+S: Save file 
Ctrl+V: Paste  
Ctrl+P: Print  
Ctrl+C: Copy 
Ctrl+Z: Undo 
Ctrl+Y: Redo 
F1: Help 
Ctrl+Shift+U: Full screen 
Ctrl+Shift+F: Find in files 
Ctrl+Shift+B: Display or hide the shortcut bar 

 

 

 

 

SHORTCUTS FOR THE WAVEFORM CAPTURE ONLY 

3 Toggle between 3-phase and individual phase views 

I Toggle between Line-to-neutral voltages and Line-to-line 
Voltages Only if recorded as a WYE 

L Select a different waveform 

f Toggle fundamental harmonic 

 

Page Up: Move to previous WaveForm Capture 

Page Down: Move to next Waveform Capture 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example 1: Standard Waveform Capture graph 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example 1A: Using the 3 to toggle between 3-phase and 

individual phase views 
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SHORTCUTS: 

 

 

Example 1B: Use the L to select different waveforms 

 

  Example 1C: List of Waveforms 

 

 

 

 

Example 2: With Fundamental displayed 

 

Example 2A: Without Fundamental. Toggle using the 

‘f’key 
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GETTING STARTED:  

Installing ProVision: 

 The latest ProVision software can be installed 

from the PMI website: 
http://www.powermonitors.com/download/software 

 The latest USB driver – needed to connect all 

recorders to ProVision, can also be downloaded 

from the PMI website: 

http://www.powermonitors.com/download/drivers 

 Software CDs are available on request 

 Save and execute the .msi files then select all 

the default options during the installation. 

 

CONNECTING RECORDERS: 

 
USB  

 ProVision automatically scans for any 

connected PMI recorder 

 Detected recorders are displayed in the Devices 

Tree in ProVision 

Cell modem  

 PMI Technical Support will need to be 

contacted to initially configure your cell devices 

 Select the Recorder tab, then select Connect 

Recorder and the recorder name or serial 

number listed 

Serial 

 Serial Serial recorders will need external power 

applied to the recorder 

 Select the Recorder Tab, then select Connect 

Recorder and the PMI USB Adapter Cable 

 

Example 3: Connecting to a PMI recorder  

BlueTooth 

 First, use the PC’s BlueTooth  manager to pair 

the PC to the  recorder  

(pmi   is the pairing code) 

 Use the Outgoing COMM port number that is 

created to configure ProVision.  

o Select the Options tab, then 

Communications Port Settings. Click the 

Add button, then serial. Name the 

connection and select a Serial Port 

number. Check the “This is a Bluetooth 

Connection” box and Save. 

 Select the Recorder tab, then select Connect 

Recorder and the BlueTooth recorder name 

WiFi 

 First, use the PC’s Network manager to 

connect to the recorders WiFi network.  

Use the recorder’s WiFi address when 

configuring ProVision.

 

http://www.powermonitors.com/download/software
http://www.powermonitors.com/download/drivers
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GETTING STARTED: 

 

 

 

 

 

 

 

 

 

Example 2. The ProVision® user interface 
 
THE PROVISION USER INTERFACE 

1. Menu Toolbar: File, Edit, View, Report, Graph, Tools, Options, 
      Recorder, Scheduler, Window, and Help menu 
2. Standard Buttons: Create a New Project, Open, Save, Save Graph 
As Template, Merge Files, Print, Print Preview, Cut, Copy, Paste, 
Delete, Edit Report Header, Find in Files, Undo, Redo, Send Via 
E-mail, Receive Via E-mail, and Sync Mobile buttons 
3. Graph Annotation Buttons: Pointer For Annotation, Text 
Annotation, Horizontal Line Annotation, Vertical Line Annotation, 
Arrow Annotation, Line Annotation, Pointer Annotation, and X 
Axis Annotation buttons 
4. Advanced Buttons: Capture View, Scale Factor, New Mixed 
      Graph, Legend Editor, and Select Plots buttons 
5. Waveform Buttons: V/I Waveform, Real Power Waveform, 
Harmonic Graph, Vector Graph, Parametric Waveform, and 
Record Waveform buttons. 
6. Trace Moving Buttons: Unlock X Axis, Left Justify On Axis, 
Center Justify On Axis, and Right Justify On Axis buttons 
7. Recorder Buttons: Add, Retrieve Settings, Initialize, Identify, 
Date and Time, Standby, Ready, and Add Event buttons 
8. Communication Group Window: Displays the status of           
      communication tasks. 

9. Explorer Tree: Watcher folders, Recent Downloads, Graphs and 

     Reports, Projects, Searches, Imported Files, Deleted Files 

10. Devices Tree: Recorder Initialization Settings, Events, and 
connected recorders 

11. Provision Shortcuts 

12. Properties Window: Properties of currently viewed graph 

13. Main Workspace: Main workspace where all graphs and reports 
will open 

14. Date, Time, and ProVision® Intercommunicator Status: Place 
file in Projects folder, right-click on the file, and select Send by 
E-mail 

15. Select Send selected object to the following address (Microsoft 
Outlook users only) and type in recipient’s e-mail address, or 
select Save object to file you could send later, type in file name, 
browse to desired directory, save the file, and send via e-mail as 
an attachment. 

16. View Menu. Use the View menu to hide and unhide the 
Communication Group Window, Explorer Tree, Devices Tree, 
Shortcut Bar, Status Bar and Properties Window. These can 
also be pinned or unpinned so that they are either always 
displayed or automatically minimized when the cursor is 
moved away from them. 
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GETTING STARTED: 

RETRIEVING AND SETTING THE RECORDER’S DATE  

AND TIME 

Click Recorder menu and select Date and Time 

To synchronize recorder time with PC time, check box for  

Use PC Time and click OK. 

 
 

VIEWING REAL-TIME DATA 
Make sure recorder is in Ready mode, click on Recorder  

menu, and choose from Waveform Graph or  

Meter Display submenus. 

 
 

UPLOADING FIRMWARE 

New ProVision versions  check for Firmware updated. 

To manually download firmware go to: 
http://www.powermonitors.com/download. 
• Click Options menu and select Show Advanced  

    Operations 

• Click Recorder menu and select Upload Firmware. 

 
 

DOWNLOADING A RECORDING 

• Click on the Recorder menu and select Download  

     Recording. Name the recording when finished and  

     initialize. 

 
 
 
 
 

 
ANALYZING DATA 

• Select file by checking box left of the file   

    name under PMI Explorer Window. 

• Click Report or Graph menu and select desired report  

     or graph or double-click on the file name to open the  

     header report. 

• To create a custom graph or report, use the Custom  

   Graph Wizard 
(Click Tools menu and select Custom Graph Wizard) 
 
 

SENDING DATA BY E-MAIL 
• In the Explorer Tree of Provision, Right click on 

'Recent Downloads' select 'Open in Explorer'. A 

window with all your data files will open. You can 

copy and paste from here to your email.  

• If the file is larger than 10 Mb, you can right click    

   on the file name and select 'Send To' then   

   'Compressed (zipped) folder'. This creates a  

   <filename>.zip folder. 

 
CUSTOMIZING SETTINGS 

Click the Options menu, and select Preferences. 

NOTE: Unfamiliarity with these choices when changing  

settings may have undesirable results. 
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USING THE WATCHER FOLDER: 

A Watcher folder gives the user the ability to store 

and open ProVision data files in locations other than 

the default C: drive location. 

Commonly, Watcher folders are configured to 

access network drives, making it easier to share 

data files with other users. 

When downloading a data file from a PMI recorder, 

the user can select a Watcher folder as the stored 

location, or can store the data file to the default 

Recent Downloads location and move or copy the 

data file to the Watcher folder at a later time.    

 

Add Watcher Step 1: Right-click on ‘Data File Sources’ to add a 

new watcher folder 

Opening Files: To open a ProVision data file, double 

click on the file name in the Recent Downloads 

folder or another Watcher folder. The Header 

Report will be displayed. Alternatively, place a 

check in the box to the left of the data file name, 

and then select any report or graph under the Menu 

Toolbar tabs. 

 

Add Watcher Step 2: Select Add Watcher then select the 

location of the new Watcher folder   

 
Add Watcher Step 3: A Watcher added Recursively will display 

all subfolders in addition to the data files 

Moving Files: Select the data file and Left-click the 

mouse to drag the file from one watcher to 

another.  

Copy Files: Select the data file, Right-click the 

mouse and select Copy, then select the destination 

Watcher folder, Right-click the mouse and select 

Paste. This creates a second copy of the data file. 

Deleting Files: Select ‘Recent Downloads’ or another 

Watcher name, then Right-click the mouse and 

select ‘Open in Explorer’. In the window that opens, 

Right-click and delete the target data file. 
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UPDATING FIRMWARE: 

Recent versions of ProVision include the Upgrade 

Manager which allows the user an easy way to 

ensure that the ProVision software and the recorder 

Firmware are up-to-date. 

 

The Upgrade Manager is displayed when ProVision 

is started. Selecting the Upgrade button, when a 

new ProVision version is available, will close, update 

and reopen Provision. Selecting the Update button, 

will copy the Firmware files to your PC.  

Updating Firmware: When a recorder is connected 

to Provision, the recorder’s firmware is checked 

against the firmware files stored on the PC. If the 

recorder’s firmware is out-of-date, the user will be 

asked to update the firmware after the next 

recorder download.  A ‘New Firmware Available’ 

balloon will also be displayed. 

 

 

After downloading the recorder, the user will be 

asked to update the Firmware. The recorder will 

also need to be reinitialized. 

 

To hide the Upgrade Manager, select the Menu 

Options tab and Preferences, then de-select ‘Check 

for Updates on Startup’. 

The Upgrade Manager can be maually opened by 

selecting the Menu Help tab and ‘Check for 

Updates’  
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REVOLUTION and EAGLE 440 HOOKUP DIAGRAM: 
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REVOLUTION AND EAGLE HOOKUP: 

When connecting the Eagle, keep the following in mind: 

• The banana jacks are color-coded by channel: Black - Channel 1, Red - 
Channel 2, Blue - Channel 3, Yellow -Channel 4, and White - Common. 
(Not all channels may apply, depending on your model Eagle.) 

• The unit is powered from the voltage between Channel 1 (Black) 
and common (White). For this reason the Black and White inputs 
must be connected even if you are not using all the input voltage 
channels. Do not exceed 600 volts RMS channel-to-channel or 
channel-to common. 

 

 

 

 

 

 

 

1. Wrap the CTs around the      2. Connect the Common (White) 
                   conductors with the arrows             voltage lead to the Eagle; and 

                  facing towards the load. Then        connect the voltage clip to the 
                    connect the CT cable to the              according to your circuit  

  Eagle.                                                               Type. 
 
 
 
 
 
 
                     
 
 
 
 
 
 
 
 
 

 
 

 
 

When using a three-phase Eagle to monitor a single-phase 
system, either unplug the unused leads and connect them in 
parallel so that all channels are recording the same information, or 
clip them to the Common connection to avoid noise readings. 

• When all CT channels are not required for hookup, unused 
channels may be connected as desired for additional monitoring. 

Locate the hookup diagram on the other side of this Quick Start 
Guide that corresponds to your circuit type. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
3. Connect the voltage leads for            4. Connect the Channel 1 (Black) 

Channels 4 (Yellow), 3 (Blue),                      voltage lead to the Eagle; then 
and 2 (Red) to the Eagle; then                    use the dolphin or alligator 
connect the voltage clips to  clip         to attach it to the correct 
the indicated Channel 2, 3,                            conductor. 
and 4 conductors. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: It is important to connect the Channel 1 voltage lead last, since this will start 
the two-minute countdown for recording.  
The LED on the side of the Eagle will blink every other second during the  
two-minute countdown.  
Once the two-minute countdown is completed, recording begins 
and the Status LED will blink once every six seconds. 
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 DISCONNECTING AN EAGLE 440: 

 
1: If possible, use ProVision to place the  
     recorder in Standby Mode to stop recording. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  3: Remove the Common (White) voltage lead  
                                 from the recorder, and then remove the  
                                 voltage clip from the conductor 
 
 
 
 
 
 

 
2: Disconnect the CTs from the recorder then  
    remove them from the conductors 
             
 

 

 

 

 

 

4: Remove the connected voltage leads fom  
    Channels 4 (yellow), 3 (blue), 2 (red), and  
    1(black) from the conductors, then remove  
    the leads from the recorder.
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APPENDIX A: VIP, IVS-3 REV2, and IVS-3/600P HOOKUP DIAGRAMS: 

 

 


